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Licensing and Copyright Agreement

This software is Copyright ©1997-2015 TED and ©TRI-EDRE.

Except as permitted under copyright law, no part of the program or this manual may be reproduced or distributed in any form or by any means without the prior written
permission of TRI-EDRE.

The program, and this manual, are licensed only for individual use on a single computer. You are permitted by law to make working copies of the software program, solely for
your own use. No copy (original or working) may be used while any other copy is in use.

If you ever sell, lend, or give away the original copy of this Software program, all working copies must also be sold, lent, or given to the same person, or destroyed.

Limited Warranty

TRI-EDRE warrants to you that the Software will perform substantially in accordance with the Documentation for the ninety (90) day period following the date of delivery of the
Software to you. If the Software fails to meet the specifications of the warranty set forth above, TRI-EDRE liability and your exclusive remedy will be replacement of the CD or a
reasonable effort to make the product meet the above warranty specification. Except for the above express limited warranties, TRI-EDRE makes and you receive no warranties or
guarantees, express, implied, statutory or in any communication with you, and specifically disclaims any implied warranty of non infringement, merchantability or fitness for a
particular purpose. TRI-EDRE does not warrant that the operation of the program will be uninterrupted or error free.

In no event will TRI-EDRE be liable for any loss of use, loss of profits, interruption of business, or indirect, special, incidental or consequential damages of any kind, however
caused and under any head of liability, arising out of use of or in connection with the software.

Trademarks

Tri-BACKUP is a trademark of TRI-EDRE.

All other products are trademarks of their respective companies.

©OTRI-EDRE. All Rights Reserved.

TRI-EDRE
22 Place de I'Eglise - 83510 LORGUES (FRANCE)
Web site: www.tri-edre.fr - www.tri-edre.com
Email address: contact@tri-edre.fr « contact@tri-edre.com
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Introduction

Welcome!

Thank you for your confidence in purchasing our backup software Tri-BACKUP 7! We are certain that you will find Tri-BACKUP 7 to be the essential tool to protect your data.
You can start by reading the next chapter, "Getting Started', if you are new to Tri-BACKUP.

Thank you for registering

Thank you for registering. You can receive free technical support and be informed of updates and developments of this product, and all the innovations of our production.
If you purchased our software on TRI-EDRE’s web store (download purchase), you are automatically registered, and you do not need to register again.

If you purchased our software from a reseller or within a bundle, please use the registration page on our web site http://www.tri-edre.com.

License

You can purchase a license to fully use Tri-BACKUP (see our website). Licenses are available for the "Standard" and for the "Pro" version. A "single-user" license allows the
installation and simultaneous use on two machines. Multi-users licenses are available for use on a larger number of machines.

If you do not have a serial number, you can use Tri-BACKUP 7 in demo mode.

Latest version of the software

Check our website http://www.tri-edre.com to verify that you have the latest version of this software. If this is not the case, you may download the latest version which allows
you to use your serial number.

Note: serial numbers are compatible with all versions of the same main version number: a serial number for version 7.0 can be used with versions 7.1, 7.2, etc. A serial number from a
previous version (5 or 6, for example) can not be used with Tri-BACKUP 7.

Note: Tri-BACKUP can check the latest available version and download it. See Preferences.

Software Installation

On the CD-ROM that came with this software, or in the disk image you downloaded, the installer is "Tri-BACKUP 7 Installer". Double-click this installer and click the Install button.
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Uninstalling Software

Use the installer "Tri-BACKUP 7 Installer". Double-click this installer and click the Uninstall button.
Note: You can also uninstall Tri-BACKUP 7 from the application, with the Tools menu.
Note 2: If you just want to stop the operation of Tri-BACKUP in the background, open the Tri-BACKUP 7 Preferences and uncheck "Launch Tri-BACKUP Scheduler at startup".

Launch and Register Software

Double-click the application icon to launch it. At first launch, the application will ask you to enter the Administrator password (the one you use for each update of the system or
applications). Then, a dialog asks you to enter your serial number (found on a sticker on the CD sleeve, or provided by e-mail or mail).

This serial number, that is personal, actives all the features of your software.

Keep your serial number in case you need to access technical support or updates.

Trial version

At each launch, you will be asked for a serial number if your version is not registered. To use Tri-BACKUP 7 in demo mode, wait until the demo button is active. The demo version
is fully useable, but is time limited (and some functions could be limited).

You can enter the serial number at any time by selecting the Register item in the Tri-BACKUP 7 menu.

Technical support

Above all, use this guide and the other guides, and our website to check all information on this product and its use. If you do not find the answer to your questions, please
contact our technical support by e-mail (see contact information below).

Please have your serial number, your version number, and characteristics of your system ready before initiating contact.
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Contacts

If you have comments about this program, problems or issues that are not answered in this manual or on our website - or if you are interested in site licenses of software -
please contact TRI-EDRE (specifying the version and serial number of your copy):

by e-mail address:

contact@tri-edre.com
support@tri-edre.com

by mail:
TRI-EDRE
22 Place de I'Eglise
83510 Lorgues
France
Web site:

http://www.tri-edre.fr
http://www.tri-edre.com
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Getting Started

Tri-BACKUP offers a wide range of options to fit your needs. But first, here are some basic actions.

Make a bootable copy of your hard drive

Why?
A copy of your internal drive will allow you to restart immediately in case of problems, while keeping your environment, your applications and settings, without having to
reinstall the System or applications.

How?

You must have a second drive able to boot your Mac and with a compatible format (GUID Partition and Mac OS extended format). Create a "Bootable Copy" programmed action
and start running.

You can schedule the execution of the action to have it executed periodically, so that the copy is updated regularly.

Backup your data

Why?
The best protection of your data is to have a copy (the ideal is to have multiple copies stored in different places). In case of accidental deletion or loss, you can still use the data
from your backup.
Of course, it is important to have an updated backup. A backup that date a year ago was much less interest!

How?

You must have a backup disk. Create a "Copy Folder" action (to backup the contents of a single folder) or a "Mirror Backup" action (to backup multiple folders in a single
operation), enter the folder or folders to backup (such as your "home" or your "Documents" and "Images', etc..) and set a regular schedule. The backup will be performed
automatically without needing your intervention.

What next?

You have now set up a basic protection of your data.
You can then go further in the use of Tri-BACKUP to refine its action according to your needs.
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Basics

Backups

A backup is a copy of all or part of your data. If you lose the originals, you can use the copy.
Tri-BACKUP allows many ways of copying and backup to fit your needs.

Important: Tri-BACKUP copy your data by keeping the hierarchical organization of folders. The copy is identical to the original, and can be used and restored directly
from the Finder, without going through Tri-BACKUP.

Actions

For all operations (copy, backup etc..), you create an action and define the settings that suit your needs. Then, you launch the action manually (or set the automatic execution).
Tri-BACKUP offers "Programmed Actions" and "Immediate Actions".

The "Programmed Actions" have been designed to perform copy and backup operations transparently. They keep your settings (you do not have to redo the setting each
time) and run automatically (you can also run it manually). Their execution is done in the background and you can continue to use your computer during this time.

Note: The automatic execution may be programmed according to various criteria (frequency, the mounting of a disk or on quitting an application, etc.) and may be associated with
a context (home, office, nomad). You can choose certain actions to be executed only in the current context (for example, that certain actions execute at the office and not when your
computer is at home).

Note: The manual execution can be done from the Programmed Actions panel of Tri-BACKUP 7, but also from the Tri-BACKUP 7 Scheduler process, with the possibility of using quick
launch shortcuts.

The "Immediate Actions" were created to visualize, check and compare the contents of folders or disks, when you wish to check the content, or if you want to choose specific
files or folders to copy or treated.

You can create as many different actions as necessary.

The operation and organization of Tri-BACKUP

The Tri-BACKUP 7 application is used to create actions and define the operation.
Note: Once you have defined actions, you can quit Tri-BACKUP 7. The automatic execution of your actions will be managed by other applications described below.

The automatic execution of actions is managed by a process (a standalone application called "Tri-BACKUP 7 Scheduler") that runs continuously in the background and launch
actions based on what you decided. This process displays a small icon in the menu bar.
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The execution of the programmed actions uses another standalone application called "Tri-BACKUP 7 Execute".

The documentation for Tri-BACKUP 7

This guide in PDF format can be opened from the application (Help menu). You can also download this documentation on our website.

In addition, you have in the application multiple context-sensitive help panels.
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Strategy for your backups

Why save?

The computers and disks are reliable, but sometimes fall down. In addition we can make mistakes and accidentally delete data. Finally a computer can be destroyed or stolen.
We must bear in mind that the data in our computer are not completely safe. If the data have any significance, we must save them (in other words, keep copies).

In addition, a copy of your hard drive can save a lot of time in case of failure, because you can immediately restart the copy to continue using the computer without having to
reinstall everything.

What to Backup?

The answer to this question is closely related to your use of the computer. It will not be the same if you use a computer to surf the internet, if you keep your personal data
(photos, etc.), or if it is your work tool and it contains many data you have created.

Here are some questions to consider (not exhaustive):

If lost, what data | can easily retrieve or reconstruct (eg, applications and data that can be found easily on the internet) and what data would be unrecoverable (the
photos of an exceptional event, the project you are working, etc.).?

The answer to this question, you'll know what to absolutely save.

How important is this data?

For important data, you will have to heart to save regularly and keep multiple copies in several locations.
What time do | will save with a backup?

For some data that could be found and reinstalled, you can choose to make a copy that will save time. This is for example the case of a copy of the primary disk, immediately
usable in case of problems.

What is the ratio of security / cost for me?

We increase the security of data by multiplying backups and medias (disks, etc..), which has a cost. The choice will not be the same for a company whose data is vital, for a
professional who has all his work on his computer or a casual user.

Where to store backups?

Obviously keep its backups next to his computer is good security in case of problems with the computer, but not in case of burglary or fire.
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For important data, you have to think to have other copies in other locations (hard drives stored in different locations, online backups, etc.).

Note: It is of course possible to encrypt a disk or data if you wish them to remain accessible only to authorized persons.

The copy of your hard drive

Make a copy of your startup disk to restart quickly, with your usual environment, your settings, your applications and documents, if something goes wrong with your hard drive.
Itis also a very simple solution if you want to replace the drive of your computer.

Tri-BACKUP can make copies of your disks, including complete and bootable copy of a disk containing a System. You can easily set the periodic execution of such a copy action,
so that the copy is updated regularly and automatically and remains identical to the original. For this, use a Bootable Copy programmed action.

What type of backup to use?

Tri-BACKUP allows several types of backups to suit all needs.

The bootable copy of a disk can be used to create an emergency disk.

The backup mirror provides an identical copy of one or more disks or folders and then easily retrieve a specific document or an entire file after an accident or loss of files.
Note: Caution! Any "mistake" made in the original (damaged, modified or deleted item) is reflected in the copy during the next backup.

The evolutive backup creates an identical copy of one or more disks or folders, and keeps the successive versions of each document. So you can retrieve an older version of a
document or folder.

Note: This backup type requires more space than a mirror backup and grows gradually as backups are executed.
The incremental backup backs up all or part of one or more disks or folders into a new folder each time. You keep the successive versions of a document or an entire disk.

You can combine these different types of backup. Use evolutive backup to save your entire disk, or files particularly valuable. You can use the incremental backup for current
projects (the data you are working regularly).

Create configurations for each backup

It is better, more flexible and more efficient to create multiple configurations rather than a single backup of all your data. Indeed, some data are more important than others,
some are changed very often and others rarely, and so on.

Use the possibility to create multiple configurations to optimize your backup strategy. It will take less time and occupy less space.

Also made from time to time, global backups and when it makes sense, schedule frequent backups of your important files or sensitive data (clients, projects you're working on
right now, etc.).
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Backup multiple networked computers

Tri-BACKUP lets you backup all volumes mounted on the desktop. You can, from your desktop, save the contents of the disks of other computers on your network, possibly with
different configurations for each machine.

You can also reserve a disk on a server for backups of all machines in your network. In this case, each machine will have its own backup folder.

Examples of use

Here's how | use Tri-BACKUP, in association with multiple internal disks, several external hard drives, space on web servers, and use of services like Dropbox.

Copy of the primary disk: Very important! To be able to restart quickly if something goes wrong, | have a copy of my primary drive, which is updated regularly (every day). In
fact, | have several copies physically stored in different places.

Copy of current work: Regular copies of documents, with keeping of older versions. The disk where the copy is made is itself backed up and multiple copies are kept in
different places.

Backups of my pictures: The size of these data is more important and are managed separately, but also there with several copies in different locations.

Backups on the Internet: Regular copies of data on the Internet (encrypted). The size of these data is limited because internet does not (currently) allow easy transfer of large
volumes of data. The data is encrypted to increase their protection. This is a copy of last chance, if no other copies would recover the data.

Transfer and data synchronization: Actions regularly update the data between different machines, using the local network.

Transfer and data synchronization between two remote disks: Actions allow you to use a portable disk (even smaller than the disks to be synchronized) to compare the
disks and copy the differences.

Data transfer via the Internet: Some synchronization of data between machines that are not on the same geographical location go through internet. Copy of encrypted data
on a web server, and recovery and decryption on an other machine.

Using transfer services such as Dropbox: Data is stored in a disk image (sparsebundle) encrypted. Tri-BACKUP copies the data to the disk image (after it mounted
automatically) and another machines retrieves the data transferred by the service.

Note: a sparsebundle disk image is composed of a set of small files and only the modified pieces are transferred, thus reducing the transfer. The use of a standard disk image (one big
file) would transfer all of the disk image for each change.
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Which action to chose?

For all operations (copy, backup etc..), you must create or open an action, then define the settings and launch it (or set the automatic trigger).
Tri-BACKUP offers "Programmed Actions" and "immediate Actions".

The "Programmed Actions" are designed to keep the settings (to avoid having to repeat setup each time) and run automatically (although they can also be launched manually
by the user).

The "Immediate Actions" were created to visualize and compare the contents of folders or disks, if you wish to check the content, or to choose specific files or folders to copy
or treated.

Note: There are immediate actions that correspond to each of the programmed actions.

How to choose a type of action?
Depending on your needs, you choose the type of action that best suits them. Needs can be diverse, Tri-BACKUP has different actions.

You will find below an explanation corresponding to the main needs.
Copies and backups

You wish to copy your boot disk
The goal is to have an identical copy of your primary disk directly usable. We can then restart from the copy if necessary, or if the primary disk has a problem.
Use the programmed action "Bootable Copy": The copy will contain the system, your applications, documents and settings (an exact copy of your environment).

If you wish to make a punctual copy, disable the auto-execute settings. Once the action is created, you launch it manually in the panel "Programmed Actions," with the button
"Execute Now".

If you want the copy to be automatically and regularly updated to keep it the same as your main drive, program it to run periodically (eg daily).

Note: The first execution will be long (since everything will be copied). Subsequent runs will be much faster because only a portion of the data will need to be updated.

You want to make a backup of the contents of a folder
The goal is to have a copy of certain documents.

Use the programmed action "Copy Folder": The copy will contain an exact copy of the original. Each execution of the action will update the copy, adding new files and
replacing the modified files.

Note: If you want to do this operation one time only, you can use an immediate action "Copy".
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You want to make a backup of several separate files
The goal is to have a single backup for several folders.

Use the programmed action "Mirror Backup" that allows you to save multiple folders or disks. The copy will contain a folder for each source folder / disk, each of these folders
containing the exact copy of the related original.

Each execution of the action will update the copy, adding new files and replacing the modified files.

You wish a backup that keeps previous versions of each document

The goal is to have a backup of your data with the latest version, while retaining the successive versions of files (when only the latest version is kept with the copy or mirror
backup actions).

Use the programmed action "Evolutive Backup": The copy will contain a folder for each source folder / disk, each of these folders containing the exact copy of the related
original. Each folder also contains a specific hidden folder where the the old versions of changed or deleted files are kept.

Each execution of the action will update the copy, adding new files and replacing the modified files (the old version is moved to the specific folder).

You want to make a new separate backup for each execution
The goal is to have, for each new backup, a new copy of your data in a new folder.
Use the programmed action "Incremental Backup": The copy will contain a folder for each source folder / disk, each folder containing the copy of the related original.

You can choose to copy, for each execution, only the recent files (old files are not copied to the backup), or all files from the source (the copy is complete and all files will be
copied each time, including those who had not been modified since the last backup).

You wish to backup to an FTP server
The goal is to have a backup of your data to an FTP server (eg internet).

Use the programmed action "Copy to FTP Server" which allows you to save multiple folders or disks. The copy will contain a folder for each source folder / disk, each of these
folders contains the exact copy of the related original.

Each execution of the action will update the copy, adding new files and replacing the modified files.
Note: This action is similar to the ‘Mirror Backup".
Note: You can use an immediate action to review and select items to copy.

You want to make a local copy of an FTP server
The goal is to have a copy of the data from an FTP server on a local disk.

Use the programmed action "Copy from FTP Server": The copy will contain an exact copy of the original. Each execution of the action will update the copy, adding new files
and replacing the modified files.

Note: This action is similar to the action "Copy Folder".
Note: You can use an immediate action to review and select items to copy.
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You want to compare the contents of two folders
Use Immediate Action "Compare": The list shows the different items. Select files or folders and click the Compare button and the action will compare the contents of each file.

The results are displayed in a list.

You want to synchronize two disks physically distant

The objective is to synchronize two large disks that are not physically accessible simultaneously by using a third portable disk (which does not need to be as big as the two
disks) that you can move from one disk to the other.

Use the actions "Create MagicProfile" and "Sync with MagicProfile". You first create (with the action "Create MagicProfile") a "snapshot" (profile) of the contents of one disk
(profile created on the portable disk). Then you compare this profile with the contents of the other disk with the action "Synchro with MagicProfile" and only the differences
will be copied to the portable disk to be copied in turn on the first disk.

Note: The actions "Create MagicProfile" and "Sync with MagicProfile" also exist as immediate action.
Synchronization

You wish to synchronize the contents of two folders
The objective is to perform the update of two folders by copying the missing documents and the latest documents in the other folder.

Use the programmed action "Synchronize two Folders": The contents of the two folders will be strictly identical after synchronization. Each execution of the action will update
the two folders, adding new files and replacing older files with the latest version.

Note: If you want to do this operation from time to time, you can use an immediate action "Synchronize".
Synchronization modes: You can use two modes of synchronization:

- The direct synchronization (Synchonize by comparing the contents of each folder) compares the contents of folders and replace the old files with new ones, and copy the
missing files. The options provide different behavior for the missing items.

- Synchronization of changes (Synchronize by comparing the changes since the last synchronization) compares the current contents of each folder with the previous
contents to detect what has changed. Items that have been modified, added or deleted on one side since the last synchronization will be copied (or deleted) on the other side.

Note: To synchronize with change detection, Tri-BACKUP saves (after each synchronization), in each folder, the list of items in this folder in a special reference file (and invisible)
named ".tbu_foldercontents_forsynchro.data". During the first synchronization (or if the reference file does not exist), a direct synchronization is performed.

You want to synchronize two disks physically distant

Use the actions "Create MagicProfile" and "Sync with MagicProfile" (see previous page).
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Other Actions

You want to compare two states of the same disk
The objective is to compare the contents of a disk with its content as it appeared at a previous date (eg before / after installing an application).

Use the action "Create MagicProfile" to create a "snapshot” (profile) of the initial content of the disk. This creates an identical copy (as would the action "Copy Folder") but the
copied files are empty and the copy obtained has a very small size (it can be saved to a disk image for reference).

Then use the "Analyze" option in the immediate action "Sync with MagicProfile" to list the differences.

Note: You can also use the action "Compare" by comparing the date of the files (the sizes are of course different).

You want to regularly empty the contents of a folder
The aim is to regularly clean specific folders (temporary work folders, caches, etc.).
Use the programmed action "Delete Folder": With each execution, the contents of the folder will be deleted (note that the removal cannot be cancelled). The folder itself is not
deleted.
You want to compress (and encrypt) the contents of a folder
The goal is to convert each file in a folder to a compressed file (and possibly encrypted with password).
Use the programmed action "Compress Folder": For each execution, each uncompressed file will be replaced by a compressed version.
Note: The compression format is a proprietary format of Tri-BACKUP. Tri-BACKUP is necessary to decompress and restore the original file.
Note: If you want to compress a copy (not the original), use the action "Copy Folder" and select the compression in the options.

You want to uncompress (and decrypt) the contents of a folder
The goal is to revert each compressed file in a folder to the original document.

Use the programmed action "Uncompress Folder": For each execution, each compressed file will be replaced with the original uncompressed version.

You want to change the visibility or change the owner of the items in a folder
The goal is to edit each file and each folder.

Use immediate action "Modify Folder".
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Tri-BACKUP 7 - The main application

Itis from this application that you create and manage your actions. It is also in this application that you have the reports and tools available to you by Tri-BACKUP 7.

The main window

The main window contains the buttons on the top for creating and managing actions, and buttons on the left for different tools. Clicking a button displays the corresponding
panel in the center:

Welcome: To start and quickly create your first programmed actions.

Create Action: This panel allows you to create the programmed actions.

Programmed Actions: This panel lists all the programmed actions that you have created. You can edit and run manually.
Immediate Actions: In this panel, you can open an immediate action or re-use of the latest actions.

Restoration: This panel allows you to restore data that had been saved by Tri-BACKUP.

Latest actions: Results of the last programmed actions executed.

Tools: Offers various tools and reports.

Volumes: Displays information about the currently mounted disks.

Check status: Panel to check the general state of Tri-BACKUP (useful for sending a report to the technical support).
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Welcome

For your convenience, you can easily create from this panel two basic actions (the first ones that anyone should create): a programmed action to make a copy of your internal
drive and another action to save your "home" directory (your user folder).

0006 & Tri-BACKUP Pro 7

TN SN+ NG MO A
Nast' ) N aat™S T NARE™ S T e

Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration

Where to start?
You can start by creating your first actions to copy your startup disk and backup your most important data to another
disk (for better security).

g | Create a bootable copy of your startup disk... Create...

Wl This programmed action will copy your startup disk to another disk. The action can be executed regularly to update the
copy. If necessary, you can restart from the copy or use it to restore or replace your internal drive.

Backup your Home folder... Create...

% This programmed action will copy your user data ("Home"): documents, photos, music, videos, emails, settings, etc. The

Volumes
action may be executed regularly to update the copy of your data.

TV

Check status

And then?

Now that your data is secure, you can create as and when you need them other actions to copy, backup, synchronize
and archive your data.
Take some time to discover all that Tri-BACKUP can do for you!

(7] Open Users Guide...
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Create Action

This panel displays the different types of programmed actions available. By clicking the top selector, you can view all types (All Actions) of action in the list or certain types
(Basic Actions, Backups, FTP Backups, etc.). Other Actions list the types that are not in the previous categories (but these actions are also displayed in the All Actions
selection).

When you select a type of action, its description is displayed to the right.

000 % Tri-BACKUP Pro 7
™ o ™ o ™ o ™
J - J - J T =

Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration

™ ? ‘ M Basic Actions Backups FTP Backups Other Actions
‘e |

All"'Actions
Last actions

+ Create Action...

Bootable Copy
Create a bootable copy of a startup disk

=

Bootable Copy

Use this action to create a bootable copy of

i Copy Folder your startup disk. This copy can, for example,
Copy the contents of a folder be used to king i d ly with
the same i in case of probl on

Synchronize Two Folders your disk (copy updated regularly), to

duplicate a boot disk with its environment on
multiple machines, or to create a reference
copy of a new System.

Synchronize the contents of two folders

Volumes

1 Display Alert
2

Display an alert, launch a file, etc Warning! You can not choose the current

7 = startup disk as the destination, because the
N J ] \ Mirror Backup system will not accept that modi1i§ations on
") B Backup a set of folders or disks items in use. Start from another disk to restore

Check status your startup disk.

= BEVE'U(I\dle BaCklllpl i £ each fil The bootable copy will be done in a hard disk,
e o either internal or external. The copy will contain an

To create an action, double-click a type of action in the list (or use the Create Action... button).

A simple editor for the type of action you chose is displayed. It allows you to set the name you want to give this action, the basic settings of the action (depending on the type
of action) and basic settings for the automatic execution.
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Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration

™

Last actions

Title: | New action (Bootable Copy) » \
Source Disk Destination Disk

E) MBP15 HD H » E SSD MBP15 HD v

121 GB used (30%) on 399 GB Actually 123 GB used on 249 GB
After copy 121.GB will be used (48%)

This disk can boot a Mac (Intel). Valid for a bootable copy (GUID for Intel)
Keep the folders already in the root of the destination disk (and absent from the source disk)

entire disk
You can cre Ota n t on disk
CAUTION! The extra data in the destination will be deleted with the default settings

Check status

(7] What will be done by this action?
o Automatic Execution: None =
< Cancel o Check with an Immediate Action + Create...

Click the Cancel button to return to the list of types of actions without creating the action.

When your settings are done, click the Create... button. The settings are saved and this new action is added to the list of actions (accessible by the panel "Programmed
Actions") where it can be edited or launched later.

Dialogue offers you to edit the action or launch it immediately.

Note: The simplified editor only offers the basic settings of each type of action. Other settings and filters are available in the editor of programmed actions. Open the "Programmed
Actions" and double-click an action to edit it.

What will be done by this action? displays a brief description.

Check with an immediate action will open an immediate action with the settings defined for this action. You can directly check the effect of your settings.
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Programmed Actions

You will find in this panel a list of all the programmed actions that you have created. The list can be sorted.

N
Nagk's)

Welcome

ar

Last actions

Volumes

N
N aatV 4

Check status

Add: The popup menu! * ¥

Groups: You can create groups to organize actions as needed. You move action in a group by drag / drop. The actions can be displayed in a single list or hierarchical groups.

Filter: You can filter the list to display only certain types and context, and use a text search on the title and source and destination items (to show only the actions of a particular

disk, for example) .

Edit: You can duplicate an action, edit it to change settings or delete it. Edit the action to have full access to all the options of automatic execution.

Activate/Deactivate: Both buttons ON and OFF on bottom right let you enable or disable the automatic execution of selected actions. If you select a group, the execution of

all actions of this group will be changed.

Create Programmed Action

NG
J

v . Backup Disks to External HD

2 Actions

& Tri-BACKUP Pro 7

All Actions

Programmed Actions

e Copy Data > HD Data (eAdmin)

TR Data (HD Data;

i Copy MBP15 HD > HD2 (SSD)

) Backup Disks to Portable HD

v
2 Actions

<> Copy Data > TR Data Copy

TR Data Copy

- Copy MBP15 HD > TR System

» TR System
> Backups to FTP

6 Actions

— Backups to NAS
>

2 Actions

Test

Ld| 59 Actians

>

on top left of the list lets you create an action or a group.

(sAdmin)

(*Admin)

(«Admin)

Fo

MO
e

Immediate Actions

Actions: 41

™
J e

Restoration

Sort by Name

Last: Today at 10:47 AM
Next: Tomorrow at 10:40 AM

Last: Today at 12:30 PM
Next: Tomorrow at 12:30 PM

Last: Today at 2:50 PM

Last: Today at 2:30 PM
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Note: The automatic execution of programmed actions can be associated with a context (home, office, nomad). You can choose certain actions to be executed only in the current
context (for example, that certain actions execute at the office and not when your computer is at home).
Action execution

You can manually launch a programmed action at any time, either if the automatic execution of the action is enabled or disabled. Select the action (or the group) and click the
Execute Now button.

Open an immediate action with the settings of the selected action

Click on the button | O | to open an immediate action with the settings of the selected programmed action. You can use this function to check the result of an action
after his execution, check the settings or make a minor update manually.

Other operations

Use the popup menu 7o edit, duplicate and delete the selected action. You can also:
Estimate the size...: This function will start executing the selected action to calculate the size of which would be copied, replaced, or removed by a normal execution (but
this execution does not copy or change anything).
Create a restore action...: This option creates a programmed action with settings corresponding to the selected action (for example, if an action copy folder A to folder B,
the restoring action will be set to copy the folder B to folder A) .
Show last executions: Displays the history of past executions of the selected action, with the files copied or modified and any errors that occurred during the execution.

Execution of actions by a keyboard shortcut
You can manually launch a programmed action at any time through a keyboard shortcut that will open a launch window (Tri-BACKUP 7 does not need to be launched).

You set the keyboard shortcut in the preferences of Tri-BACKUP 7 Scheduler. For example, if you set the keys "Ctrl + right arrow" as a shortcut, you press both keys
simultaneously (at any time and from any application) to make the launch window appear, where you can choose the action to launch in the list (possibly after filtering by
name or quick code assigned to an action or a group).

Note: You can assign a quick code for each action or group to find and launch it quickly.

Example: You have assigned the code "bk3" to a group containing three actions. Type the shortcut to bring up the launch window, then enter "bk3" in the search field and hit "Enter"
to launch these three actions.
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Immediate Actions

Buttons allow you to create a new immediate action for the most common types. The Other popup menu allows the creation of immediate actions of any available type.

% Tri-BACKUP Pro 7
7 /\ y “'\., G ™ ° \‘\. 9 ™
JN J J VA 4 J e

Restoration

Welcome Create Programmed Action Programmed Actions Immediate Actions

Create new immediate action
Sl . & >3 2 i
Last actions i — 05_; Others ~
Copy Synchronize Copy to FTP Compare
Actions: 70 Actions of All Types + | (QSearch Actions -
Action Source Destination Date
# Copy Folder Source Dest#5 1/29/14, 1:50 PM
N = Copy Folder Source Dest#4 1/29/14, 1:49 PM
J . = Copy Folder Source Dest#3 1/29/14, 1:48 PM
Volumes = Copy Folder Source Dest#1 1/29/14, 12:36 PM
= Copy Folder Source Dest#2 1/29/14, 12:36 PM
N # Modify Folder Photos en attente (in TR Data 1/26/14, 11:13 AM
J ‘/ = Copy Folder thierry (in MBP15 HD) thierry (in SSD MEP15 HD 1/25/14, 12:38 PM
Check status = Copy Folder thierry (in MBP15 HD) thierry (in TR System 1/25/14, 9:59 AM
4= Restore Folder Tri-BACKUP 7 (in 55D TM HD)  Tri-BACKUP 7 (in MBP15 HD) 1/24/14, 4:54 PM
%% Copy from FTP Server 192.168.0.12/tests source (in MBP15 HD 1/24/14, 4:51 PM
= Copy Folder Tri-BACKUP 7 (in M8P15 HD)  Tri-BACKUP 7 (in MEP15 HD) 1/21/14, 3:43 PM

This panel lists the last immediate actions, ordered from most recent to oldest.

You can filter the actions displayed by type and with a search on the name of the action, the source or destination.

Double-click an action to use it again (with all existing settings).

A window opens for each specific type of immediate action (see "Immediate Actions" chapter in this manual).
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Restoration

This panel displays the options for restoration.

s Tri-BACKUP Pro 7
7 ,‘/\ '\O ™ ° ‘\o ™
JN J - J - J - J =

Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration

o

é Restore from Recent Backups

Search recent actions that have backed up a particular folder

Last actions

A l Restore Folder
J X = Restore the contents of a folder Note: To restore data that was backed up by

_ Tri-BACKUP, you can also select the
Tools —* \ Restore Bootable Disk programmed a.ctlo‘n that made !htbac,kup and
e Restore a disk from a bootable copy use the y by g the
~ menu "With the selected action...” at the
\ . bottom of the list of programmed actions.
J 4 _*Q Restore Evolutive Backup prog
« Restore the contents of a folder from an Evolutive Backup Information:
Volumes *
'@\ Restore Time Machine backups When Tri-BACKUP is running a backup or copy,
™ e Restore the contents of a folder from a Time Machine backup each file is copied in accordance with the

hierarchy of folders. To restore data backed up by
Tri-BACKUP, you can:

- Copy items by hand from the Finder.

- Use an immediate copy action to check what is
different and choose what to copy.

- Use a programmed action (for example copy or

hantahla aami ta anmi tha data fram tha hanbsin

TV

Check status

By the principle used by Tri-BACKUP for its backups (ie copying files to the same preserving the folder hierarchy), you have multiple ways to recover data backed up: manual
recovery from the Finder, use of an immediate or programmed actions and use of specific recovery.

The various restoration actions offer the options and exclusion filters to restore exactly what you need. The restoration can be done automatically (with a
programmed action) or manually using an immediate action.
Restore from Recent Backups

To restore a particular folder, this function shows you what are the programmed actions that have saved it and where the data were saved. You can easily find the backup you
want and restore from this backup.
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Restore Folder

This function is similar to the programmed action "Copy Folder", but some options have been activated for the Restoration: uncompress compressed files and the ability to
overwrite files with the saved version, even if it is older.

Note: You can change the basic settings to suit your needs.

Restore Bootable Disk

This feature allows you to restore a System disk. It is quite similar to the programmed action "Bootable Copy", but some options have been activated for the Restoration:
uncompress compressed files and the ability to overwrite files with the saved version, even if it is older.

Note: You can change the basic settings to suit your needs.

Restore Evolutive Backup
This feature allows you to restore a folder that was saved with a programmed Evolutive Backup action, choosing the date of the backup to restore.

Note: You can change the basic settings to suit your needs.

Restore Time Machine backups

This feature allows you to restore a folder that was backed up by Time Machine, choosing the date of the backup to restore.

Last actions

This panel displays the list of the last executed programmed actions (the most recent being at the bottom).
For each action, are displayed time, date and duration of execution and results summaries (number of files, errors, etc.) .

Select an action to display a list of the items copied or treated as well as the list of errors . Each line displays the name and path. An icon indicates the type of operation (see the
meanings in the Help menu).

Note: Only 5000 last items are preserved for history of each action, and only the latest histories (olders are deleted).
Other results... button at the bottom right can display histories from older actions or other machines by directly selecting the file where the data is stored .

The default folder is the "History" folder, but you can go in old backups or on other machines to select contents of this folder.

Tools

This panel gives quick access to various tools provided by Tri-BACKUP.

Edit Common Filters
Programmed actions and immediate actions have filters to exclude certain files or folders, or otherwise treat only certain files or folders.

Each action has its own filters, but you can also create sets of filters that you can use in several actions (eg if you need identical filters for these actions).
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Clean Evolutive Data
Actions "Evolutive Backup" keep the extra data (old versions, etc.) in specific folders that are invisible by default.

With this tool, you can make these folders visible or remove some of this data to free space on the backup disk.

Global Disk Change

When you define a source or destination folder in a programmed action, Tri-BACKUP records information on the disks containing these folders to detect it if necessary. In
addition to the disk name, Tri-BACKUP saves the size and creation date of the disk, to distinguish, for example, two different drives having the same name.

If you change or reformat an internal or backup disk, you must redefine each action to set the new disk.

This tool allows you to globally change the references to a disk for all the actions that use it, which greatly simplifies the change.

Show Logs and Messages
During operation, Tri-BACKUP and associated processes record various information about their activity.
This tool displays a window that lists the latest logs.

Show Daily Reports
Displays activity reports day by day.

Note: These reports can be automatically sent daily by email to the recipient of your choice (you specify in the Preferences).

Other Tools

Some other tools are available in the Tools menu.

Access the Settings folder...
This menu displays the folder in the Finder where are saved all settings and reports of Tri-BACKUP. This folder is located in the /Library/Application Support/ folder of the user.
The /Library/ folder is hidden by the System and the menu gives you easy access to it.

Copy the settings of Tri-BACKUP on mounted volumes...
This menu automatically creates copies of the contents of the Settings folder (list of programmed actions, reports, settings). The copy can be used when needed (loss or erasing
of the disk, change of computer) to find settings and logs. It is possible to program copies on multiple disks to increase security.

Export a list of the contents of a disk/folder...

Tri-BACKUP can create a list of content and save it in a file. You can keep the files of various contents for later analysis or comparison or to easily send the list (for technical
support or otherwise).

Note: The resulting file contains only the names of files and folders (no data from the files is added).
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Open a list of contents...

This function is to read the list of previously saved content to view, navigate and search the folder structure or the recorded contents.

Volumes

This tool displays mounted volumes and shows different information on each disk: size, format, useable as a boot disk, etc.
Check disk speed: You can make a summary measure of disk access speed. This tool gives an indication and does not claim to replace specialized tools.

Volumes Free Space: Tri-BACKUP records regularly occupied space on the mounted disks. With this tool, you can view the evolution of the occupation of your disks. You can
then decide when it will be time to change a disk to a bigger one, or clean a disk to make free space.

Check status

This panel gives you an overview of the general state of Tri-BACKUP and its associated processes. You can use it to check the status of the application? You can copy the
summary text and send it to our technical support when needed (it will help us see the context if you have a problem).

Window Menu

Other features are available in the Window menu of Tri-BACKUP.

Show Mac and Tri-BACKUP activity...

This window shows the periods of use, stop and sleep of your computer and Tri-BACKUP. For example you can check if the execution of an action was interrupted by a sleep of
your computer.

Show CrashLogs...

This window displays the diagnostic reports for Tri-BACKUP applications and process (you can also access it via the Console).
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Edition of the Programmed Actions

To edit a programmed action, select the panel "Programmed Actions" and double-click the action.

e 00 Bootable copy of my startup disk (Bootable Copy Editor)
E: Action © Trigger ¥* Options X Filters Before /After

Action Type: | 233 Bootable Copy & Color: | None =
1
Action Title: IBootabIe copy of my startup disk I Quick Code:
Comments:
Copy the contents of: To:
= MBP15 HD D) -—) = HD System D

Actually 121 GB used on 299 GB

(o After copy 121 GB will be used (40%)
Format: GUID partition (Intel Mac) Format: GUID partition (Intel Mac)
This disk can boot a Mac (Intel). Valid for a bootable copy (GUID for Intel)

121 GB used (30%) on 399 GB
System Mac OS X 10.9.1

I Destination distributed over several volumes? 1

Volumes detection mode:
@Strict detection (check the volume name, size and creation date, and if the path exists)
(_) Accept any volume with the same name (if the path exists)

Cancel || Save \

5 @ Last: Never executed | @ S |
‘\;/‘ Next: Execution disabled - ummany::
Number of executions: 0

Settings of Programmed Actions (and Immediate Actions) are edited in a window. One window is opened for each action that is edited.

Panels
The edit window has always the same organization in different panels, accessed by clicking the top bar.
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Action: To set the type of action, the title you want for this action (for easy retrieval in the list) and the basic settings (source and destination, for example).

Trigger: This panel allows you to define the conditions of automatic triggering of the action (at a specified time or after specific events, such as mounting a disk - to execute
a backup on this disk - or when you leave an application - to copy or backup data modified by this application, for example). You can set multiple trigger conditions (eg
every week, and also if you connect the backup disk).

Options: This panel is specific to each type of action. You will find options for copying, using compression, permission to delete files, etc..

Filters: Filters are used to exclude certain items (eg not to copy temporary data and unnecessary files) to lighten the copy or treatment, or not to modify certain files or
folders. A button allows you to Test Filters to check their effect on the action.

Before/After: In this panel, you can define conditional operations to be performed before or after the execution of the action. This may be sending a message in case of
error, the execution of a script or to exit an application before the execution of the action, the execution of another programmed action, etc.

Summary of execution
A summary of the use and settings of execution is displayed in the bottom left of the window.

Summary of settings

The Summary... button at the bottom of the window displays a text of all settings of the action. You can use it to check your settings globally, but also to send the settings to
our technical support if needed.

Save Changes
When the settings suit your needs, click the "Save" button.
If you wish to cancel changes and return to the previous settings, click "Cancel".
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Action panel

e 00 Bootable copy of my startup disk (Bootable Copy Editor)

E] Action © Trigger 2 Options X Filters Before /After
Action Type: | 389 Bootable Copy 2 Color: | None 2
e
Action Title: IBootabIe copy of my startup disk l Quick Code:
Comments:
Copy the contents of: To:
(3 MBP15 HD D) = (B HD System 4]
121 GB used (30%) on 399 GB Actually 121 GB used on 299 GB
System Mac OS X 10.9.1 o After copy 121 GB will be used (40%)
Format: GUID partition (Intel Mac) Format: GUID partition (Intel Mac)
This disk can boot a Mac (Intel). Valid for a bootable copy (GUID for Intel)

[ Destination distributed over several volumes? 1

Volumes detection mode:

@Strict detection (check the volume name, size and creation date, and if the path exists)
(_) Accept any volume with the same name (if the path exists)

/ .} \ e Last: Never executed
‘\;/‘ Next: Execution disabled
Number of executions: 0

| @ summary... | | Cancel [ | Save \

The first panel lets you change the type of action and the title that you wish to display (it makes sense to customize the title of each of your actions in order to more easily
identify them when you need to modify them or execute them ).

The Quick Code can be used for manual quick launch of the action, particularly from the Scheduler. See the chapter about Tri-BACKUP 7 Scheduler in the manual Tri-BACKUP
7 (QuickStart Guide).

You can assign a color to display the action (always with the aim of identifying more easily).

A comment box is available. These comments are not used during the execution of the action, but you can use it as a reminder, to inform another user, summarize what the
action is, or specify the terms of use.
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The lower part of the panel action depends on the type of action chosen.

For most actions, it shows the source and destination folders or disks.

Disk (bootable copy)

A popup menu lets you choose among the currently mounted disks, the source (left) and the destination where the copy will be done (right). The area under the menu tells you
the size and variety of information on the selected disk, especially if the source disk contains a system and if the destination format is compatible to make a bootable disk.

Note: The information "size after copy" of the destination disk is given for the case where additional data already present on this disk (and not in the source disk) will be removed (you
can change this behavior in the Options panel).
Folders or drives (other actions)
If you choose a type of action different from the bootable copy (and Alert), one or two areas for selecting a folder or a disk are shown.
You can choose a folder (or disk):

- Drag and drop that folder from the Finder onto the area.

- With the "+" green button if no choice has already been done.

- With the popup menu at the bottom right, by selecting one of the newly defined items or Choose ... that opens the selection dialog.
- With the popup menu displaying the current folder showing the hierarchical path, to choose one of its parent folders.

Copy the contents of:

[ source v |

& v | MBP15 HD/Utilisateu...Cocoa/Tri-BACKUP 7
This volume is HFS formated

v |

The popup menu under the folder icon displays the folder in the Finder and its contents.
The rotating arrow starts a calculation of the current size of the file.
FTP server

For actions where the source or destination is an FTP server, the area shows the server.

You can edit the server information by clicking the edit button in the area (or "+" green button if no choice has yet been done).
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FTP Settings

Server: 72.252.7.128
Login: myname
Password: esecsccscsce
Path: private/backup

New connection for each access
Note: Use this option only if you have problems to access the
server.

FTP server is accessible with these settings.

Test
ok.png 7.97KB  1/13/14,2:44 PM  rw-r--r--
Capt..8.png  10.98KB 1/13/14,3:01PM rw-r--r--
- ﬁles TWXr=Xr-x
CUFVY -+ dC8A e -Xr-x
Previous Settings ¥ Cancel | OK |

Note: In the editor of the FTP server, a "Test" button allows you to verify that your settings are correct to access the server (the server content is displayed in the list).

Detection mode of the volumes
You can choose between two methods of detecting the volumes:

- strict detection of a volume (if two disks of the same name should not be confused). The strict detection checks information of the disk (name, size and creation date of
the disk) to differentiate two discs that have the same name. This is usually the option to choose to avoid confusion between two discs (but it is highly advised to give
distinct names to each of your disks).

- tolerant detection: This mode only checks the name of the disk. This mode can be selected, for example, if you use two alternating backup disks of the same name for the

same action (one for the even days, one for odd days).

Important: Any initialization, repair or reformatting of a drive can change its size and creation date. In this case, if you use strict detection, you must redefine the
items (source and destination) of the actions using this disk.

Automatic mounting of volumes
Tri-BACKUP can automatically mount remote volumes needed to perform an action.

Note: If Tri-BACKUP mounts a volume, it will unmount it after the action.
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To do this, put an alias of the remote disk, with as name exactly the volume’s name (without additional extension) in ~/Library/Application Support/ Tri-BACKUP 7/Alias/.
You can access this folder using the menu Tools > Access to Settings Folder.

Note: To save the volume password, unmount the remote disk, then double-click the alias and select "Save password in keychain" Thus, the password will not be asked when Tri-
BACKUP mount this volume.

If an action needs this disk (and if it is not mounted), Tri-BACKUP searches in the Alias folder for an alias of that name and, if so, uses it to mount the disk automatically .
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Trigger panel

A programmed action can be launched manually at any time.

Tri-BACKUP offers controls for your actions can run automatically without your intervention to secure your data without having to worry about.

e 00 New action (Bootable Copy) (Bootable Copy Editor)

Bj: Trigger ¥ Options XK Filters Before /After

Settings for automatic execution:

v

(M Execute this action automatically Execution context: | Any Context 3|
[ Execute only if all necessary volumes are mounted

When: | Every Day At... $| 15:30 |:J
Custom Programmed Scheduling: | + v |;’
When Next
All weeks: Monday Wednesday Friday - 11:15 AM On 2/3/14 at 11:15 AM
All months: First day of month - 5:25 PM Tomorrow at 5:25 PM

With these settings, next automatic execution will be: Today at 3:30 PM

Protection against unwanted launching:

[ ] Prevent this action from being launched manually

|| Prevent this action from being launched by remote control

- @ Last: Never executed
'?' Next: Today at 3:30 PM | i Summary... l | Cancel I ‘ Save ‘
Number of executions: 0

The checkbox "Execute this action automatically" allows you to enable or disable the automatic execution of the action.

The checkbox "Execute only if all necessary volumes are mounted" stops execution if the volumes are not present without trying to mount them via aliases (a message You

can define one or more scheduling, but also executions triggered by events (for example, to execute a backup when a drive is connected, or save documents when you have
finished and quit a particular application).

Predefined triggers are accessible through the menu "When" and "+" button allows you to add periodic triggers (daily, weekly, monthly, etc.)..
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indicates that the action could not be executed).

Protection against unwanted launching

The options allow you to lock the manual launch or the remote launch of the action.

Notification in case of non execution
You can be alerted (message or email) if this action is not executed for several days while his the automatic execution is activated (eg if the conditions of his execution are not
met).
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Options panel

The options are specific to each type of action.
There are however options common to several types of actions:

e 00 Copy Data > HD Data (Copy Editor)
g“ Action © Trigger ¥ Options X Filters Before/After
Execution: \ Execute with full permissions (administrator mode) =

Use this mode to access or copy protected data (System, other users in the machine, etc.), or to copy permissions. Do not use when
accessing a remote disk through a network.

Do you want to copy the attributes of files and folders?

[Y]Copy Owner, Group and Permissions

Do you want the files to be compressed, encrypted, or uncompressed during the copy?

|} No Compression e | | Password |

Should we delete the files and folders already in the destination and which are no longer in the source?

(M Delete items from the destination that are not in the source
[ | Delete these items before copying (to free space)
[_| Ask before deleting a large folder (containing more than 20 MB or 50 files)

Extra Settings:
@Allow older files to replace newer files

|| Force Folders permissions to Read-Write (in destination)
|| Compare each file with the original after the copy (this is a double check)

/ 5 e Last: Yesterday at 10:47 AM
N\, Next: Execution disabled
Number of executions: 95

Cancel | Save \

| @ Summary... |

- Execute with the current user / Administrator permissions: With Administrator mode, the entire disk is available, including the System and the accounts of other users.

With the permissions of the current user, other accounts may not be copied nor the System.
Note: We usually use the "current user"mode unless if you want to copy the data to all users. Administrator mode is automatically activated if you chose a "Bootable Copy" action.

- Copy owner and permissions: Every file and folder has an owner and permissions. You can choose to copy these attributes (in this case, you must set the Execute with
Administrator option), or conversely to have the default attributes (the copy will have the current user as owner).
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- Compression: You can chose to have every file saved or copied as compressed (which reduces the size of the backup) and possibly encrypted with a password (the
recovery of each file can only be done if you have the password wich was used to encrypt the file).

Note: Compression and encryption routines are proprietary. Tri-BACKUP is necessary to restore the original file.

- Delete: If the folder (or disk) destination already contains items that are not in the source folder (or disk), you can delete them or not. Delete gives an identical copy of the
original, but any error made on the original will be reproduced in the destination.

Note: For Bootable Copy actions, you can choose not to delete the folders already present on the root of the disk (eg if the destination disk already contains data that you do not want
to delete during the creation of a bootable copy).

- Replace newer files: Normally, recent files replace the old files, but it may be useful to replace a file by an older version (eg if in the original file is reverted to an earlier
version of a document). This option authorize the replacement.

Other options
For Evolutive Backups, there are specific options for the keep life of data (given that the latest version of each file is always preserved).

Specific settings for Evolutive Backup:
| Make Evolutive Data visible

@ Remove older versions after: 30 Days

Retain a maximum of: 4 Versions

For Incremental Backups, you can set after how long - or how many executions - backups are deleted.

Specific settings for Incremental Backup:

Partition the Backup in folders with a maximum size of: MB
| | Remove previous backups after: 7 Days
|| Remove previous backups if more than: 10 Backups

For Synchronization, the action normally copy the recent files and files that are missing. You can change the behavior of this action:
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Specific settings for Synchronization:

Synchronize by comparing the contents of each folder v
(») Copy missing files in both directions

() Copy missing files from left folder to right folder only
() Do not copy missing files (update existing files only)
Synchronization replaces older version of each file by the newer version.
If a file is only on one side (and missing on the other), it will be copied to the other side. Any file deleted on one side will
be copied again (if it exists on the other side).
You can use two modes of synchronization (from the popup menu):

- Direct synchronization (Synchronize by comparing the contents of each folder) compares the content to replace the old files with new ones, and copy the missing files. The
options provide different behavior for the missing items.

- Synchronization of changes (Synchronize by comparing the changes since the last synchronization) compares the current contents of each folder with the previous contents
to detect what has changed. The items modified, added or deleted on one side since the last synchronization are copied (or deleted) on the other side.
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Filters panel

The filters are used to exclude certain items of a copy or a backup.

There are a number of predefined filters, such as. DS_Store (which contain the settings for each file format), aliases, invisible items or the contents of the Trash or Caches.

You can also create an exclusion list of files or folders based on their name, size, etc.

Note: The items excluded are ignored: they are copied or deleted.

Copy Data > HD Data (Synchronize Editor)

8 O 0
Action ° Trigger | ¥ Options Filters
Filters:
|| Exclude .DS_Store files || Documents only
|| Exclude Aliases |_] Exclude Evolutive Backup data

|| Exclude Invisible

|| Exclude files modified before the last execution:

Use a set of filters (defined in the Tools menu) that can be used for multiple actions:

@ Exclude Caches, Logs, Virtual Memory, MobileBackups, etc.
~-> 30/01/2014 10:47:36 0

8

No Set of Common Filters selected

A
v

[ Use this set of Common Filters: \

@ Use the filters below (specific for this action):

(+] (=]

To add an item in the list of filters, you can:

Mode Name Extension Label Size Modification date
© (0 starts with ".Trash"
© [ is "Xtra data (not to backup)***"

| Test Filters
.} @ Last: Yesterday at 10:47 AM | [ﬁ S | C | | | S
N Next: Execution disabled E UMY ) ance ) ave

Number of executions: 95

- Drag and drop a folder or file on the list: It will automatically be taken as a reference for the filter.
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- Click the "+" button: The filter editor will open.
- Drag and drop a filter for the edit window of another action (or from the window of the common filter).

To edit an existing filter, double-click the filter in the list.
You can add as many filters as necessary. The execution of the action will only process files and folders that are not excluded by a filter.
The "Test filter" button will display a window showing for each item in the folder (or disk) source, whether it is excluded by filters or not.

Common filters

With Tri-BACKUP, you can create sets of filters that you can use for various actions. Changing a set of filters modifies all the actions to which it applies.
The edition of the common filters is located in the menu (or panel) Tools.
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Filter Editor

The edit dialog displays various filter options:

Filter Mode:

© (o) Exclude matching items
[+ ) Include only matching items

Type of items:

() All (Files and Folders)
( )Files
.1 (s)Folders, Bundles, Packages...

Items with a path, a name, an extension or a label matching:

™ | The name is equal to 3| | exactly... =

Xtra data (not to backup)***

| | The extension is one of these: | Extensions separated by ","

a»

[ | The label is: ® None

Files with a size or a modification date matching:

\ The size is smaller than... 2 100 | KB 3|

| The modification date is older than... s | 02/11/2013 13:54

Cancel | [ OK ]

Choose Example...

- Filter Mode: A filter can be used to exclude certain items (eg exclude all files that are larger than 10 MB) or instead to include only some items (eg copy only files with the
extension "jpeg ").
- Type of items: You can choose a filter applying only to folders or files.
- Name and extension: Here you specify the criteria for detection of items involved in the filter.
- Criteria on files: You specify the criteria in the area to filter depending on the size and modification date.
Note: The criteria of size and date do not apply to folders.
The button "Choose Example" takes a file or folder as an example, and copies the information of name, extension, size and date of the example.
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Before / After panel

You can perform conditional operations before or after the execution of the action, such as sending a message in case of errors, launching another action if this action was
successful, remove a disk or launch a script or application after the action.

6 O 0 Copy MBP15 HD > TR System (Bootable Copy Editor) .
EW j © Trigger ¥ Options X Filters Before /After

If errors or problems are encountered during the execution of this action:

(M Display a message if errors
|_| Display the list of errors at the end of the execution

Things to do before or after the execution of this action:

[ Message... ] [ Launch... ] [ Unmount... ] [ Shut Down... ] [ + v] [3
Condition To Do 7

Before Launch: TR System.sparsebundle

After if errors Send an email to: trolland@me.com

After Unmount: TR System

- Last: Y d. 2:30 PM ( ) ( 1 ( ]
@ @ Naei:t: Eexsf:ce\rm?)ynad(lsabled | E Summary... | l Cancel I | Save I

Number of executions: 103

The "+" button displays a menu to select the operation to perform.
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Display a message
Send an email (Pro only)
Play a sound

Execute another action
Launch a file, script, or application

Quit an application
Unmount a Volume
Shut down this machine

In the editor, you can choose from the popup menu the condition for the operation to be performed: before or after the execution, in case of error or when copying files, etc.
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Immediate actions are intended to visually check the condition and contents of two folders or control what you want to copy or delete.

Immediate Actions

It is recommended to reserve the use of immediate actions to verifications and specific operations. For overall performance, it is best to use a programmed action.

Window for immediate action

Opening an immediate action opens a window displaying the contents of the selected folders and information for comparison and possible operations.

e 00 Immediate Action [Copy Folder]
Action Type: [T Copy Folder =

To:

(~

Copy the contents of

et | GE Tri-BACKUP Execute v | » - ™| Tri-BACKUP Execute v

¢ (click to get the size) & (click to get the size
‘ @ v ’ MBP15S HD/Utilisateurs/thi...UP 7/*Tri-BACKUP Daemons =y @ v ‘ SSD MBP15 HD/Utilisateurs...P 7/*Tri-BACKUP Daemons
- This volume is HFS formated ) - This volume is HFS formated
Drag and drop a folder or a disk,or... [ @@ v | & Drag and drop a folder or adisk, or... [ @@ v
|| Show invisible items (#) Show all items
| | Display real name (not localized) () Show only items that are different
oo R o —
v [ Sources © [ Sources
H = H executeActions.z p

executeActions.zip

@ ExecuteActionThread.h |h) ExecuteActionThread.h

B ExecuteActionThread.m =, B ExecuteActionThread.m
\h’ ExecuteController.h = lh] ExecuteController.h
Im| ExecuteController.m > m ExecuteController.m
129.21 KB (129,210) - 1/31/14, 3:16:54 PM (%25 129.09 KB (129,091) - 1/29/14, 4:08:12 PM
r:thierry (501) staff (20) - Read and write (-rw-r { . Owner:thierry (501 staff (20) - Read and write (-rw-r--r
| #+ Settings... | (¥ Hide the items excluded by filters | Analyze...

(2>
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Action Type
At the top (in the black band) is a popup menu to choose the type of action.
You can also choose from this menu one of the programmed actions you have created (and thus take the appropriate settings).
If you change the type of action, the settings and the buttons are modified (if necessary) to accommodate the new type.

Note: If the settings are compatible, they are kept (for example, a "copy" action changed to "synchronization" will take the same folders but the buttons at the bottom and the
presentation of the list will be changed).

Areas of folders selection

Below the menu are areas where you can choose the folder (or disk) to process. You can drag and drop a folder or disk on one of these areas, or use the popup menu at the
bottom right in the box to select the desired folder.

Note: The menu offers a list of folders or disks you have recently viewed.

Display options
Invisible items: This displays (or hides) the invisible files and folders in the list.
Real names: This option displays (or hides) the real names (not translated).
Note: Mac OS X automatically translates certain folder names when displaying the Finder windows (for example, "Library" will be translated).

View All / Only differences: The items identical in both cases are normally displayed in gray. With this option, you can hide them so that only the differences in the list are
displayed (this reduces the content of the list making it easier to find items to be copied).

Hide the items excluded by filters (bottom): The settings allow you to add filters to exclude certain files or folders. This displays (or hides) the items excluded by these filters.

The list of contents
The list shows one or two columns (depending on the type of action) and presents the content in the form of hierarchical list sorted alphabetically.

When the list displays the contents of two folders (ie with two columns), Tri-BACKUP displays on the same row items of the same name on both sides. If an item is present only
in one folder, it is only displayed on one side. The center column displays information as icons (same or different items, etc.).

Certain actions (delete, compress, etc..) only shows one column. The list displays the contents on the left and information icons on the right.

Information on selection

When an item is selected in the list, the size, date, owner, etc.. are displayed at the bottom of the list. If a folder or a package is selected, Tri-BACKUP shows its size and the
number of items.

Note: Differences are indicated in red. For example, if a file is selected and is present in both folders (then displayed in two columns), a size in red indicates that the sizes of the two
files are different.
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Settings and execution buttons

At the bottom of the window are buttons for various settings and the execution of the action. These buttons are dependent of the type of action chosen.

Settings

For immediate action, you have the same options and same filters as for the programmed actions. Click the Settings button to open a window for editing the settings.
See the guide of the editor of programmed actions for more details.
Note: Some tabs are grayed out in the editor (as trigger) because these settings are not available forimmediate action.

Analyze

Immediate actions allow you to launch an analysis of the selected items. The analysis does not change the contents but displays items that should be copied or modified if you
launch the execution of the action.

Analysis: 12 items
Copy: 6 (1.68 MB)
Replace: 0
Delete: 0
Errors: 0

/&) Modify.png.tbucry
[%| images.jpeg

| backintime2

| clonex3

" grandreporterl

| taptapl

During an analysis, the output window shows the summary and found items (with an icon for the type of operation to do for this element).
Note: You can display (or hide) the window by the button "Results" in the upper right corner of the Immediate Action window.

The results window contains a menu and a search field to display only certain items.
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If you click an item in the list, it is displayed in the main list of Immediate Action.

Execution of an action

Select from the list files and folders that you want to perform operations, and then click the button corresponding to the chosen action (if multiple buttons are present) at the
bottom of the window.

Note: As with the analysis, the results window shows a list of items processed.
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Tri-BACKUP 7 Scheduler

This application runs in the background and triggers the execution of programmed actions. It is also the main point to control backups when the main application Tri-BACKUP 7
is not launched. You can start or stop actions and monitor their execution.

It is visible only by its icon in the menu bar:

4 Open Tri-BACKUP 7...
¥¥ Preferences (Tri-BACKUP Scheduler)...
I Mount Volumes... =

& Execution Status...
© Pending Actions...
[»] Launch Programmed Actions... =

No action scheduled
Disable Automatic Execution
Suspend Execution

© Information... =

Next actions
a3 2:40 PM Copy Data > TR Data Copy
Actions executed today
991 1:30 PM [12:25] Copie Forum
Sw$! 1:16 PM [0:25] Copy Emails Boutique
More Actions...

Quit Tri-BACKUP 7 Scheduler

Clicking this icon access the various controls of the execution, and in particular, you can:

- Open the main application Tri-BACKUP 7.
- Open the Preferences dialog of Tri-BACKUP 7 Scheduler (display of the icon in the menu bar, displaying information during execution, display messages, etc.).. With these
preferences, you can make the execution of actions very discreet, or otherwise have all the tools to monitor their execution).
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- Mount volumes (if alias of these volumes are in the folder ~/Library/Application Support/Tri-BACKUP 7/Alias/), for example for the execution of an action.
- Change the status of the automatic execution of programmed actions (eg to temporarily disable the automatic execution of actions) and the execution context (for
example, when you're traveling with your laptop, so that only certain actions will be triggered automatically.)
- View the list of actions awaiting execution.
- Manually start the execution of a programmed action.
- Suspend or stop the action in progress.
In this menu, you also have the history of last executions and next actions.

Disable automatic execution of actions

If you wish to interrupt the automatic execution of scheduled actions, you can:

- Suspend (the current execution is paused): The current action temporarily stops until you resume normal execution of this action. Other actions of the queue are
themselves also put on hold.

- Disable automatic execution: The current action is completed, but the following will not be executed.

- Disable after completing pending actions: The current action terminates, and all actions that are in the queue. No new action is added to the queue.

Note: The icon in the menu bar is grayed out if the automatic execution is disabled.

Change the execution context

Each programmed action can be set to run automatically in a particular context (Office, Home, etc.).. For example, if you brought your laptop at home, you may want only
certain actions can run automatically. In this case, change the context for Home and only actions set with a Home context (or all contexts) will be executed.

Note: You can manually launch any of the actions (context intervenes only for automatic executions).

Execution of actions by a keyboard shortcut

You can manually launch a programmed action at any time through a keyboard shortcut that will open a launch window (Tri-BACKUP 7 does not need to be launched).
You set the keyboard shortcut in the preferences of Tri-BACKUP 7 Scheduler. For example, if you set the keys "Ctrl + right arrow" as a shortcut, you press both keys
simultaneously (at any time and from any application) to make the launch window appear, where you can choose the action to launch in the list (possibly after filtering by
name or quick code assigned to an action or a group).

Note: You can assign a quick code for each action or group to find and launch it quickly.

Example: You have assigned the code "bk3" to a group containing three actions. Type the shortcut to bring up the launch window, then enter "bk3" in the search field and hit "Enter"
to launch these three actions.
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Preferences of the Scheduler

You can access the Preferences by the menu or by the Preferences of Tri-BACKUP 7. The following window is displayed:

Preferences (Tri-BACKUP Scheduler)

Predefined behavior settings > Unobstrusive
Messages

Show Welcome message at startup

Show messages in Notification Center

When an action is executed

Default

Surveillance
Miscellaneous

Automatically stack windows
Wake up the Mac to execute the actions
Alert if free space on the startup disk < 10%

Alert if /Volumes/ folder contains incorrect data
Display the list of pending actions

Display the mini floating progress window
Display the progress window Keep actions in queue when computer shuts down

Report when a volume is mounted/unmounted f i tions at s actior t yet

Pending actions in queue

the pending a
Icon in the menu bar

B

gﬁ Visible when mouse over the menu bar

Latest Actions Quick View

Always visible B
Transparency: . . .

Transitory Messages

Remote Control

Allow Remote Control (by another machine)

Transparency:
. N MBPro 15 Retina Thierry

White (text) / Blue (background) E acallNEne

Click to select a position --> o= o= o=

(or drag the messages window to change the
desired position)

Password (to access this Mac):
- o omm

i

Cancel

On the left you have the display options. They allow you to closely survey the activity of Tri-BACKUP or on the contrary to be the least disturbed possible. The buttons at the top
of the window are presets, from "Unobstrusive" (you will not be disturbed) to "Surveillance" (you can check all activities). These predefined settings can then be tailored to your

own needs.
Show posts in Notifications Center: Messages are displayed using the notification system in Mac OS X.
Display the progress window: You can also view the progress by clicking on the icon Tri-BACKUP Execute in the Dock, during the execution of an action.

Icon in the menu bar: If the icon is always hidden, you can open the Preferences by Tri-BACKUP 7 (button in the Preferences window).
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Latest actions Quick View: A small window displays the status of the last executed actions.

On the right, you have the other settings of the Scheduler, and in particular:
Wake up the Mac: The Mac is awake if its activity is suspended and whether action should be executed. If the Mac is switched off, this option does nothing.

Alerts: Survey the free space on the startup disk and the contents of the /Volumes/ folder.
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Tri-BACKUP 7 Execute

This application is launched for every execution of a programmed action. Its icon appears in the Dock with a progress bar indicating its progress.

6%

You may at any time, by clicking on the icon, display the progress of the execution of the action, or stop it.

Progress Window

This window allows you to monitor the current action. It shows the folder being analyzed, the number of items compared and copied, and the space available in the destination
disk.

(%) Executing Test rapidité

keyedobjects.nib

Source/ iLocalize Documents/Folderinfos /Folderinfos/Source /Histor
y/Folderinfos (1.0 build 1.0.0) - 1/Contents/MacOS/Folderinfos

Copied: 6,395 642 MB 14s - Remaining about 40s

Deleted: 0 6,395 (642 MB) 42,989(7.7 GB)
Errors [— ‘
Available # 9.12GB | Skip... || Pause | | Stop |

You have 3 buttons in this window:
Skip ...: This function allows you to record running.
Pause: Pause the execution (the button becomes "Continue" to resume execution).

Stop: Stops the current action. The current position is stored, and at next execution, you will be asked if you want to resume from that position or start over.
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Icons meaning

In the Help menu, select "Show Icon Meaning" to display all icons and a short explanation:

[X) Icons Meaning

—
»
-~

Buknmmwg’i:‘

?
Ui

?-.fzﬁ?&é*‘%é“@%\ XY H]i] ‘ @<

Trigger activated

Trigger deactivated

Execute with admin privileges
Immediate Actions

Copy file or folder

Replace existing file

Replace newer file

Copy folder contents
Synchronize folders contents
Compress file

Uncompress file

Delete file or folder

Copy Owner/Permissions
Modify file or folder

Protected item (Time Machine etc.)
Compare files

Items excluded by filters
Execution Results

Executed successfully

Executed with errors

Comparisc Results

Identical

Different contents

Missing items

Different dates

Different Owner/Permissions
Icon in the menu bar (Schedule
Active (automatic executions)
Active (Trial mode)

Disabled (no automatic executions)
Disabled (boot disk has changed)
Executing a programmed action

Execution paused
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Error Codes

Errors are displayed with a code which you can find the meaning below:

E1 - Error: File not found (there was no file at this location)

E2 - Error: Insufficient free space in the volume to complete the operation

E3 - Error while reading the file (unable to read file information or contents)

E4 - Error copying file (unable to create the folder hierarchy or to copy the file at destination)
E5 - Error deleting file (unable to delete a file)

E6 - Error renaming file (unable to change the name of the file)

E7 - Error copying file's attributes (unable to set the correct attributes, owner or permissions)
E8 - Copy aborted by user

E9 - Files have not the same contents

E10 - Error creating or opening stream for FTP access

E11 - Error creating or opening stream for FTP access

E12 - Error with proxy, username or password for FTP access

E13 - Error with proxy, username or password for FTP access

E14 - Error with proxy, username or password for FTP access

E15 - Error: File not found (there was no file at this location)

E16 - Error creating destination

E17 - Error time out exceeded (FTP access)

E18 - Copy aborted by user

E19 - Error: Types are different (replacement of a file/folder by a folder/file is not allowed)
E20 - Files have not the same date

E21 - Files have not the same permissions

E26 - The source or destination path is incorrect

Tri-BACKUP 7 - Users Guide 59/59



